
Configuring and Troubleshooting 
Catalyst Center Templates

Alan Gardner
CEO, Current Technologies CLC, @alangardnerCT
3xCCIE #22758 
https://www.linkedin.com/in/alangard/

CISCOU-3004



© 2025 Cisco and/or its affiliates. All rights reserved.

Cisco Webex App

CISCOU-3004

Questions? 

Use Cisco Webex App to chat 
with the speaker after the session

Find this session in the Cisco Live Mobile App

Click “Join the Discussion”

Install the Webex App or go directly to the Webex space

Enter messages/questions in the Webex space

How

Webex spaces will be moderated by the speaker until June 13, 2025.

1

2

3

4

https://ciscolive.ciscoevents.com/
ciscolivebot/#CISCOU-3004

Enter your personal notes here

2



© 2025 Cisco and/or its affiliates. All rights reserved.

Agenda
01 Device Onboarding

CISCOU-3004

02 Catalyst Center Templates

03 Projects and Templates

04 Day-0 and Day-N Templates

05 CLI Template Languages

06 Network Profiles

07 Troubleshooting Best Practices

08 Troubleshooting Template Deployments

09 Template Compliance Checks

3



© 2025 Cisco and/or its affiliates. All rights reserved.

Device Onboarding - Provision Workflow

Device connected 
to the network

Device will 
search for
PnP server

Device listed 
as “Unclaimed”

“Claim” device
(Step 1)

“Claim” device   
(Step 2)

Finishing
PnP

Do not touch 
the console 
until it is 
explicitly stated 
that it is 
allowed

DHCP

DNS

Cloud 
redirection

List of 
devices 
detected by 
PnP server or 
manually 
added *

Option to change 
device name

Optional 
assignment of 
device to Site

Option to select 
software version

Option to select
onboarding 
template

Option to 
configure stack 

Enter or import 
onboarding 
template 
parameters

Configuration of 
parameters  
defined in 
network 
settings and  by 
onboarding 
template

SUDI validation

Device is 
enrolled into 
inventory and 
assigned to the 
Site 
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Use of Catalyst Center CLI 
templates can significantly 
simplify device configuration 
through its entire life cycle 
and helps to maintain 
configuration consistency.

Full 
configuration

Configuration 
changes

Onboarding
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Catalyst Center Templates
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Configuration Templates

• Segments of code
• Support variables
• Provides basic programming constructs
• Flexible

CISCOU-3004
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Template Basics

•Currently under the Design menu

•Design -> CLI templates

• In previous versions

• Tools -> Template Hub

• Tools -> Template Editor

• Cisco Catalyst Center provides an interactive 
template hub to author CLI templates. 

• Easily design with predefined configurations by 
using parameterized elements or variables. 

• Use the template to deploy your devices in one 
or more sites that are configured anywhere in 
the network.
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Template Creation Workflow

Create a new 
project

Create a new 
template

Define the content 
of the template

Save and commit 
the template

Configure the 
variables
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Projects and Templates

CISCOU-3004

Projects:

• “Folders” where 
templates are organized 
in structure

• Can be exported and 
imported 

Adding Projects:

• Name
• Description (optional)
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Day-0 and Day-N Templates 

Implications

Day0 - pull DayN - push

change IP address or interface Interactive commands

one-shot (rollback on failure) line-by-line (no rollback)

no composite templates composite templates supported

only re-push on change

CISCOU-3004
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Day-0 and Day-N Templates 

Device Configuration

ProvisionSite Settings
- AAA
- DNS

- NTP, etc

Day-N template(s)

• In “Day-0 
Configuration”, Cisco 
Catalyst Center 
generates a CLI 
configuration, including 
device credentials and 
enabling SSH for users. 

• For “Site Settings” and 
Day-N Templates, need 
"Provision"

Claim
Day 0 template

Device Credentials

PolicyQoS
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CLI Template Languages

Apache Velocity Language

• Java-based template engine

• Allows CatC to expose variables

• Allows scripting logic to be included 
in templates

• Provides:

• Source binding

• Manipulation of variables

• Conditional branches

• Loops

• Methods

Jinja

• Template engine written in Python

• Inherits many Python’s capabilities

• Allows CatC to expose variables

• Allows scripting logic to be included 
in templates

• Provides:

• Source binding

• Manipulation of variables

• Conditional branches

• Loops

• Methods and filters

CISCOU-3004
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Adding CLI Template

CISCOU-3004

Adding template (parameters):

• Template Name

• Project Name (selected from available)

• Template Type (Regular or Composite)

• Template Language (Jinja or Velocity)

• Software Type (IOS, IOS-XE, …)

• Device Family (selected from available)

• Devices (optional, selected from available 
families or models)

• Device Tags (optional, selected from 
available, used to provide better granularity 
of device selection)

• Software Version (optional)

• Template Description (optional)

Mandatory
Optional
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CLI Template Types – Regular vs. Composite

Regular

• Generates real configuration 
segments

• Can use variables

• Can use:

• Source binding

• Manipulation of variables

• Conditional branches

• Loops

• Methods

Composite

• Sequence of regular templates

• Sequence can be reordered

• Sequence can be aborted if 
deployment fails

CISCOU-3004 15
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CLI Template Types – Regular vs. Composite

Regular Composite

CISCOU-3004
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CLI Template Editor

• Template simulation
• Variable definition
• Template code creation

Editor View     Version Compare View

CISCOU-3004 17
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CLI Template Editor - History

CISCOU-3004

Highlighted 
differences

Compare 
versions

Save as latest
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Network Profiles

CISCOU-3004 19

• Template must be attached to the network profile before it is used 
to provision the device

• Different network profile types- switching, routing, wireless, …

• Each profile contains a section for onboarding templates and Day-N 
templates

• Device-to-template mapping is managed by device series/model 
selection and/or tags

• Template can be assigned to a network profile in the Design-
>Network profile section or in the Design->CLI templates section

• Catalyst Center supports up to 50 network profiles
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Day 0 (Onboarding) and Day N (Provisioning) Templates

CISCOU-3004 20

Day 0 (Onboarding) templates

• Must be in “Onboarding Configuration” 
project (available by default)

• Regular or Composite templates

• Can use Velocity or Jinja language

• Import, export and clone options

• Used for initial device configuration 
(usually during plug-and-play process)

• Some restrictions apply

• Entire configuration pushed at once

Day N (Provision) templates

• Can be in any project under existing 
Projects

• Regular or Composite templates

• Can use Velocity or Jinja language

• Import, export, and clone options

• Used to build complete device 
configuration

• Provides flexibility

• Configuration pushed line-by-line
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Enable and Interactive Mode Template Commands

CISCOU-3004 21

Using enable mode commands in CLI templates

Using interactive commands in CLI templates

• An interactive command contains the input that must be entered following the execution of a 
command

• To enter an interactive command in the CLI content area, use the following syntax

CLI_command<IQ>interactive_question_1<R>response_1<IQ>interactive_question_2<R>response_2

• <IQ> and <R> tags are case-sensitive and must be entered as uppercase  

Beginning of enable mode block

End of enable mode block

Beginning of interactive command

End of interactive command
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How to Use CLI Template for Device Configuration

CISCOU-3004 22

• Option 1 – Provisioning device from the Inventory page

• Provision->Inventory->Actions->Provision->Provision Device

• Template is pushed as part of complete device provisioning as advanced 
configuration (Network intent, Advanced configuration, Device controllability)

• In Tasks it is shown as “Provision Device” task

• Option 2 – Push template from the CLI template page

• Design->CLI Templates, select Project and Template (can be regular or composite)

• Template must be attached to Network Profile(s) (also true for Option 1)

• Only the configuration generated by the template is pushed

• In Tasks, it is shown as “Provision Templates” task (if not modified)



Troubleshooting Best 
Practices
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Template Not Deployed on Target Device

CISCOU-3004

• To understand where in the template we are experiencing an issue

•Log the lines to a file on the flash drive of the device

• Logs to reflect the changes deployed line by line from Catalyst 
Center and is  granular and clear where the template stopped

event manager applet CLI_COMMANDS-->

event cli pattern ".*" sync no skip no

action 1.0 syslog msg "$_cli_msg"

action 2.0 file open FH bootflash:eem_cli_commands.txt a+

action 2.1 file puts FH "$_event_pub_time %HA_EM-6-LOG: CLI_COMMANDS-->: $_cli_msg"

action 2.2 file close FH

event manager applet CLI_COMMANDS-->
event cli pattern ".*" sync no skip no
action 1 syslog msg "$_cli_msg"
!

term mon

24
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Using Template Simulation Capability
Available for both regular and composite templates

CISCOU-3004 25

Creates new simulationExisting simulations list Result of last run



© 2025 Cisco and/or its affiliates. All rights reserved.

Using Template Simulation Capability

CISCOU-3004

Select real device to 
run simulation against 

(device configuration will not 
be modified) 

Enter/select values for 
template(s) variables 

Save or run simulation
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Using Template Simulation Capability

CISCOU-3004

Generated  
configuration for review

(can contain debug prints)
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Dealing with Existing Configuration Overlap
In some cases, pushing already existing commands leads to failure

CISCOU-3004 28
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Dealing with Existing Configuration Overlap
‘default command’ for configured entity can often help

CISCOU-3004 29
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Removing Part of the Existing Configuration

CISCOU-3004

• Creation of a new version of the template without the given command is 
not enough

• Several possible options for solving it:

• Use the default (if possible) and recreate the configuration from scratch

• Use the “no” command to remove the desired line of configuration

• Create a section of the template to remove or swap part of configuration as 
needed 

30



Troubleshooting Template 
Deployments
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Catalyst Center Template Common Issues

CISCOU-3004 32

• Undefined variables not mapped at deployment time

• Templates in Catalyst Center often include variable placeholders that must be defined before the template is pushed 
to a device. If these variables are not mapped with actual values during the deployment phase, the system cannot 
render the final configuration correctly, leading to errors.

• Syntax errors or invalid commands for specific platforms:

• Not all Cisco devices interpret commands in the same way, and a command valid on one platform may not be 
recognized by another. For example, the command ip route 0.0.0.0 0.0.0.0 Ethernet1 might work on a traditional IOS 
device but fail on an IOS-XE device that expects an interface to be named GigabitEthernet1

• Logical errors in conditional statements (e.g., incorrect interface type)

• Logical errors  usually stem from incorrect assumptions or misused logic in the template’s Jinja2 syntax. For example, 
a conditional statement like {% if interface_type == "GigabitEthernet" %} might fail if the actual variable value is GigE, 
causing the template to skip configuration steps or apply incorrect ones

• Overlapping or conflicting configurations from multiple templates 

• Can create problems, especially in environments where multiple teams or workflows are managing devices. For 
example, one template may configure a static IP address on an interface, while another template attempts to enable 
DHCP on the same interface.
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Catalyst Center Template Validation Tools

• Use “Preview Template” to render configuration with test variables

• Before deploying a template, the "Preview Template" feature allows administrators to substitute test variables and view the resulting 
configuration. This helps ensure that all variables are correctly defined and that the final configuration will generate as expected. For 
example, if a template includes a variable like {{interface_name}}, previewing with a value like GigabitEthernet1 will show how the 
actual CLI will look on the device.

• Validate against target device type before deploying

• Different Cisco platforms interpret configurations differently, so it's important to validate the rendered template against the actual 
device model and OS version. For instance, a command like switchport trunk allowed vlan add may be valid on Catalyst 9300 switches 
but not on older Catalyst 3850 models. Validation ensures compatibility with the target device and avoids platform-specific syntax 
errors.

• Catch errors in logic, missing variables, and unsupported CLI commands

• During validation, Catalyst Center checks for common template issues such as uninitialized variables, misused conditional statements, 
and CLI commands not supported by the target device. For example, an if statement that references an undefined variable will trigger 
a validation error. Likewise, using ip ospf network broadcast on a device that doesn’t support OSPF can be flagged before 
deployment.

• Save time by catching issues before pushing to production

• Identifying and resolving issues during the validation phase reduces the risk of failed deployments, minimizes the need for post-
deployment troubleshooting, and prevents unintended service disruptions. This proactive approach not only improves deployment
accuracy but also streamlines operations by ensuring that templates are fully functional before they affect production environments.
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Catalyst Center Template Deployment Error Handling

• Review deployment logs in Tools > Template Editor > Deployment History

• Use the built-in Deployment History section under the Template Editor to access logs for past deployment attempts. This centralized 
log viewer provides detailed insight into what happened during the deployment process, helping identify at what stage the error 
occurred and what components were affected.

• Analyze logs for CLI rejection messages, variable mismatches, or timeout errors

• The logs can reveal several types of errors including rejected commands (e.g., syntax not recognized by the target device), variables 
that were not properly assigned values at runtime, or timeouts if the device failed to respond. For example, if a command such as ip
ospf 1 area 0 is invalid for the device, the log will include the rejection reason, enabling administrators to adjust the template
accordingly.

• Verify device reachability using SSH, ping, or SNMP within Catalyst Center

• Before concluding that the issue lies within the template, confirm that the device is reachable. Catalyst Center provides tools to test 
SSH connectivity, ICMP ping responses, and SNMP status. A failure in any of these checks may point to network path issues, access 
control restrictions, or device-level misconfigurations.

• Cross-check results with actual CLI output using manual login when necessary

• If automated diagnostics don't clearly explain the issue, manually logging into the device via SSH to inspect the running configuration 
and recent command history can offer critical insights. This method can confirm whether any part of the configuration was partially 
applied or help verify the current device state, which may differ from the Catalyst Center’s expected outcome.
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Catalyst Center Template Versioning and Rollback

CISCOU-3004 35

• Each edit to a template automatically creates a new version

• Catalyst Center tracks every change made to a template by generating a version history. This allows administrators to see a full audit 
trail of updates, ensuring transparency and traceability in configuration changes over time.

• Easily rollback to a prior working version

• If a newly deployed version of a template results in failure or undesired behavior, administrators can quickly revert to a previously 
known good version with just a few clicks. This capability minimizes downtime and eliminates the need to manually reconstruct
previous configurations.

• Label versions clearly for better management (e.g., “Production v2.1”, “Lab v1.3”)

• Using meaningful version labels makes it easier to identify the purpose and stability of each version. For example, “Lab v1.3” could be 
used for testing, while “Production v2.1” indicates a stable, approved configuration used in live environments. This distinction helps 
avoid accidental deployment of experimental templates to production devices.

• Use the rollback feature to mitigate failed production pushes

• When a deployment fails or introduces instability, the rollback function provides a safety net to restore previous configurations without 
delay. For instance, if a new template includes a faulty routing command that breaks connectivity, the rollback option ensures quick 
recovery to the last known-good state without needing a full template rewrite.
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Catalyst Center Template CLI Verification Commands
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• Use CLI to validate that changes were applied correctly

• Logging into the device manually and reviewing the configuration through the command-line interface ensures that the changes match 
what was defined in the template. This helps confirm success or identify any partial or failed configurations.

• show run | include [config] – Quickly locate specific configurations

• This command filters the running configuration to display only lines that match a keyword or pattern. For example, after deploying a 
VLAN configuration, use show run | include vlan to confirm that the VLAN-related lines were correctly inserted into the configuration.

• show vlan brief or show ip route – Check operational status of key features

• These commands verify whether services configured by the template are now active. show vlan brief displays all VLANs and 
associated interfaces, confirming that VLAN creation was successful.  

• show archive – Review previous configuration changes

• This command provides a versioned view of configuration files over time, allowing administrators to see what was changed by a
template deployment. It's helpful for auditing and for confirming that rollback procedures returned the system to a previous state.

• show logging – Detect command rejections or syntax errors

• This command reveals system logs that may include error messages related to invalid commands or unsupported configurations. 
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Catalyst Center Template Best Practices
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• Develop and test templates in a lab environment before production deployment

• Always build and validate new templates in a controlled lab setting. This helps identify syntax issues, 
logical errors, and device compatibility problems without affecting live services. Once verified, the 
template can be confidently promoted to production.

• Use meaningful and consistent naming conventions for templates and versions

• Standardizing template names, such as “Branch-Switch-Onboarding” or “Core-Router-v2.4”, improves organization 
and allows teams to quickly locate and identify the purpose of each template. Consistent versioning also helps with 
rollback and change tracking.

• Document variable definitions and expected values for each template 

• Provide clear internal documentation or annotations within templates explaining required variables, such as IP 
addresses, VLAN IDs, or interface names. This prevents deployment delays caused by missing or incorrect variable 
mappings.

• Regularly review and clean up outdated or unused templates 

• Periodically audit the template library to remove or archive templates no longer in use. This reduces clutter, prevents 
accidental use of deprecated configurations, and keeps the workspace manageable.
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Catalyst Center Template Best Practices (cont.)
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• Use version control to track changes and maintain a clear audit trail 

• Take advantage of Catalyst Center’s built-in versioning to document the evolution of a template. Add comments 
describing each change (e.g., “added support for Catalyst 9500 interface naming”) for future reference.

• Limit template deployment to maintenance windows when possible 

• To avoid network disruptions, schedule template deployments during planned maintenance periods or low-traffic 
hours, especially for core infrastructure devices. This ensures time for validation and rollback if needed.

• Leverage role-based access control (RBAC) to limit who can edit or deploy templates

• Assign template editing and deployment permissions only to authorized administrators. This prevents accidental or 
unauthorized changes, ensuring consistency and compliance with change management policies.

• Continuously monitor deployments and follow up with post-deployment verification 

• After pushing a template, verify the actual configuration on the device using either Catalyst Center's monitoring tools 
or manual inspection. Check for misconfigurations or differences between expected and applied settings.



Template Compliance Checks
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Avoiding Compliance Check

CISCOU-3004

Beginning of section where 
compliance is not checked

End of section where 
compliance is not checked
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Compliance Checks - Uppercase and Lowercase Matters

CISCOU-3004 41

• Simply put, uppercase and lowercase letters matter to the comparator engine

• If you look at the running configuration of a switch and you see which letters or 
words are capitalized in specific commands, that is exactly how the commands 
should look in your Day-N templates.

• If you would’ve written that command and similar ones (like on the image 
below) using an all uppercase “VLAN”, these would’ve been flagged as non-
compliant because in the running configuration, only the “V” is uppercase while 
the rest is lowercase. 
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Compliance Checks - Passwords and Secrets

CISCOU-3004 42

• Password and Secrets are used in many places in the configuration of a network device and 
most of the time, hopefully, these cannot be easily read by humans due to something like 
“service password-encryption” being configured, which would encrypt these 
passwords/secrets using Type 7-encryption.

• If you have “service password-encryption” enabled and you still have 
cleartext passwords/secrets further down in this or other templates, the 
password/secret would be marked as non-compliant.
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Compliance Checks - Shortened Commands
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• Do NOT shorten Commands in Day-N Templates

• Only use full/complete commands in your Day-N Templates or they will be 
flagged as non-compliant. Shortening commands like you probably would’ve 
done when entering them in a switch manually will not pass the compliance 
check.
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Catalyst Center Training
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Current Technologies Computer Learning Center

Administering and Troubleshooting Cisco Catalyst Center - Assurance 
(CATALYST-CENTER)

• https://www.ctclc.com/courses/cisco/catalyst-center

40 CE Credits / 45 CLCs

Dcloud Catalyst Center Labs

cs.co/DNAC-TEMPLATES

CiscoU Training

https://u.cisco.com/search?query=catalyst%20center

Outline

https://www.ctclc.com/courses/cisco/catalyst-center
http://cs.co/DNAC-TEMPLATES
https://www.ctclc.com/courses/catalyst-center/catalyst-center/administering-and-troubleshooting-cisco-catalyst-center--assurance-cata-cnt-ass
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Contact me at: agardner@ctclc.com
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